
  

 

 

 

TMWSuite 
2023.1 Release Notes 

4/2023 



TMWSuite 2023.1 Release Notes  

 

© 2023, Trimble Inc. All rights reserved. All materials and content are confidential. Unauthorized duplication, copying or use prohibited. 
 

Warnings 2 

Installation warning ............................................................................................................................................... 2 

Social Security number encryption warning ........................................................................................................... 2 

SMTP email port warning ...................................................................................................................................... 3 

Invoice output configurations warning ................................................................................................................... 3 

ALK Warning ........................................................................................................................................................ 4 

TMWSuite's mapping feature is not compatible with PC*MILER version 32 or later ............................................. 5 

2023.1 6 

Requirements......................................................................................................................................................... 6 

Enhancements........................................................................................................................................................ 7 
RateWare XL integration ................................................................................................................................. 7 

Configuration and authentication changes (TTESUITE-205288)................................................................ 7 
Order Entry ..................................................................................................................................................... 8 

PromptOnMasterSave (TTESUITE-204857) ............................................................................................. 8 

Resolved issues...................................................................................................................................................... 8 
Dedicated Billing............................................................................................................................................. 8 

2022.3.9.27 Service Pack 8 

Resolved issue ....................................................................................................................................................... 8 
Tariffs ............................................................................................................................................................. 8 

2022.1.19.34 Service Pack 9 

Enhancement ......................................................................................................................................................... 9 
Invoicing, Dedicated Billing ............................................................................................................................ 9 

Manually changing invoice status to Printed without printing (TTESUITE-204544) .................................. 9 

2021.1.1.2019 Service Pack 10 

Resolved issue ..................................................................................................................................................... 10 
Planning Worksheet ...................................................................................................................................... 10 

 
  



TMWSuite 2023.1 Release Notes  

 

© 2023, Trimble Inc. All rights reserved. All materials and content are confidential. Unauthorized duplication, copying or use prohibited. 
 

Warnings 
Important information. Please read before upgrading. 

Installation warning 
Starting in version 2020.4, you must install the TMWSuite files into a new directory. Some files from 
earlier versions are not compatible with V.2020.4 and greater. If you need assistance, please work with 
your support team. 

Social Security number encryption warning 
Starting in version 2020.2, Social Security numbers you enter in the Driver profile are encrypted in the 
database by default. 

Having encrypted Social Security numbers could interfere with third-party applications accessing the 
data. This happens because the data is encrypted when transferred. The third-party application does not 
have the ability to decrypt it. 

You can set up the system so that the Social Security numbers you enter in the Driver profile are not 
encrypted in the database.  

To do so, set the DataEncryption General Info Table setting's String1 field to N. 

Note: The Data Conversion Administration Utility allows you to encrypt/decrypt a group of Social 
Security numbers in your database. Contact your Professional Services representative to obtain the 
DataConversionAdministrationUtilityInstall.msi. 

Access and usage of The Data Conversion Administration Utility should be provided only to a system 
administrator. That utility provides access to highly sensitive data and should be used in the explicit 
instance of needing to encrypt or decrypt the driver profile. 
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SMTP email port warning 
Starting in version 2019.2, the setup for the SMTP email feature has changed. 

Now you can set these options in the SmtpEmailer General Info Table setting: 

 String1 = Identify your SMTP server 

 String3 = Identify your SMTP server username 

 String4 = Identify your SMTP server Password 

 Int1 = Specify whether Secure Sockets Layer (SSL) authentication is active 

 Int2 = Specify whether CRM Right uses Windows authentication 

 Int3 = Identify your SMTP server port as 587 or 465 

Notes: 

1. This lets you configure your system to use Secure Sockets Layer (SSL) for SMTP email. 

2. Starting in version 2019.4, you can disable Secure Sockets Layer (SSL) for SMTP email. 

3. See the description for SmtpEmailer General Info Table setting for more information about this 
setting. 

 

Invoice output configurations warning 
Starting in version 2019.1, there is a new procedure for setting up and assigning invoice output 
configurations for print and EDI. 

In previous versions, you set up output configurations in the EDI 210 field or in the Advanced EDI 
Output Settings window in the company's File Maintenance profile. 

In V.2019, those two locations are no longer available. Now, you set up invoice output configurations in 
the Billing Output Configuration Folder. To access this window, select  
Edit > Company Billing Output. 

And, you can assign invoice output configurations from either of these locations: 

 The Billing Output Configuration Folder 

 The Distribution Method window in the company profile 

Note: To access this window, you must use Screen Designer to add the Invoice Output Method 
button to the company profile. 

The upgrade script for V. 2019.1 is designed to automatically import all the invoice output configurations 
you previously set up. You should not need to do any additional setup for your existing configurations. 
However, as with any major upgrade, we recommend that you verify the results after running the upgrade 
script. 

https://learn.transportation.trimble.com/discover/result/?sub=LC/transportationmanagement/tmwsuite/productguides/settings/generalinfotablegit/&fn=SmtpEmailer-1.doc&tl=SmtpEmailer
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ALK Warning 
In very limited circumstances, your system could generate incorrect mileages when using PC*MILER 
version 32 with any of these products: 

 TMW Operations version 2018.2 or lower 

 TMW Back Office version 2018.2 or lower 

 Fuel Dispatch version 2018.2 or lower 

 TMWSuite version 2018.2.0.0275 or lower 
 

This problem is associated only with systems that have one of these options set in their TTS50: 

 [MileageInterface]ExOptions[x]=I 

 [MileageInterface]ExOptions[x]=X 
 

Having either of these options set will cause Practical mileage to be computed as Shortest, and Shortest 
mileage to be computed as Practical. 

This will not affect mileages previously retrieved and stored in the mileage table. 

The issue is fixed in the next general release, such as 2018.3 for TMWSuite. 

A temporary workaround to bypass the incorrect code is to do any of the following: 

Use an additional ExOption in conjunction with the I or X option. 

 Remove the I or X option entirely. 

 Install an earlier version of PC*MILER. 
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TMWSuite's mapping feature is not compatible with PC*MILER 
version 32 or later 
TMWSuite's (PowerBuilder) mapping feature works with ALK's PC*MILER|Mapping software to plot 
routes and symbols on a map. 

To use ALK's mapping features in TMWSuite (PowerBuilder), you must use PC*MILER|Mapping 
version 31 or earlier. 

Starting with PC*MILER version 32, ALK supports only ALK® Maps for mapping. ALK Maps is a web-
based, JavaScript API. TMWSuite does not support ALK Maps. 

If you are using TMW.Suite (.NET) or another .NET product, you can use ALK Maps. 

Notes: 

1. In TMW.Suite (.NET), support for ALK Maps is free of charge. To use it, you need a unique API key 
value. Contact your TMW support representative for more information. 

2. This change only affects the compatibility of ALK's mapping features in TMWSuite; it does not affect 
the mileage features. 
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2023.1 
This section contains the following for the latest version:  

 System requirements  

 Enhancements (new or updated features) 

 Resolved issues (application improvements)  

Note: Before upgrading your production environment, Trimble recommends that you read the system 
requirements and install the latest version in a test environment. If you have questions, please contact 
your customer representative. 
 

Requirements 
Before you begin installing TMWSuite version 2023.1, check that these requirements are met: 

 Internet Information Services (IIS) for Microsoft® Windows Server®  

IIS Microsoft Windows Server 2008 R2 or later 

 Microsoft® SQL Server® 

 Microsoft SQL Server 2012 or later 

Note: SQL Server 2012, SQL Server 2014, SQL Server 2016, SQL Server 2017, and SQL Server 
2019 are certified for use with this application. Trimble Transportation recommends using the 
latest service pack of whichever version you use. 

 .Net Framework 4.6.2 or later 

 Microsoft Visual C++ 2010 x 86 Redistributables 

 32-bit SQL Native Client Drivers 

Version 10, 11, or MS OLE DB must match the drivers to your SQL version. 

 You must be logged into the system where you want to install TMWSuite, and have 
administrator rights for that system. 

Like most applications, TMWSuite can be installed locally on a user's system. It is also possible to 
install TMWSuite on a network drive. To do so, you must be logged into the system where the drive 
is physically located, and have administrator rights for that system.  
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Enhancements 

RateWare XL integration 

Configuration and authentication changes (TTESUITE-205288) 

SMC3 has announced that soon it will no longer allow insecure HTTP connections. To accommodate this, 
TMWSuite's RateWare XL integration contains several changes designed to improve security. 

Previously, the system received credential information from General Info Table settings. Now, it receives 
this information from the token vault. 

If you have TMWSuite Addins installed and enabled, the Token Vault window opens when you go to 
View > Token Vault in System Administration. All of the keys shown in this illustration must be 
present. 

 

You can copy values for three of the keys – UserName, Password, and LicenseKey – from the 
RateWareXL General Info Table setting. 

The other key values were formerly hard-coded. Enter the values listed in this table. 

Key Value 

RateWare Endpoint https://applications.smc3.com/AdminManager/services/RateWareXL 

CarrierConnect Endpoint https://demo.smc3.com/AdminManager/services/CarrierConnectWS 
 

 

https://applications.smc3.com/AdminManager/services/RateWareXL
https://demo.smc3.com/AdminManager/services/CarrierConnectWS
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Order Entry 

PromptOnMasterSave (TTESUITE-204857) 

Previously, the TTS50 setting [Dispatch]PromptOnMasterSave only applied to Master Orders in 
Dispatch. When the setting value is Y, the system displays a message when you save an order. The 
message reads: “Are you sure you want to save this Master Order?” 

Now, [Order]PromptOnMasterSave provides this functionality in Order Entry. 

Resolved issues 

Dedicated Billing 
TTESUITE-205946 

If the ship start and ship end dates were incorrect, the status of the dedicated bill did not update. 

Also, when using SSRS reports, clicking Set to Printed did not update the invoice status. 

2022.3.9.27 Service Pack 

Resolved issue 

Tariffs 
TTESUITE-205733 

An error occurred when clicking Retrieve in these windows: 

 Mass Rates Assignment 

 Settlement Rate Schedules 

Each window appears when you go to Edit > Mass Rates Assignment in the Edit Billing Rate Schedule 
Folder and Edit Settlement Rate Schedule Folder respectively. 
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2022.1.19.34 Service Pack 

Enhancement 

Invoicing, Dedicated Billing 

Manually changing invoice status to Printed without printing (TTESUITE-204544) 

Now, you can change the status of an invoice from Ready to Print to Printed without physically printing 
the invoice. 

A new TTS50 setting, [Invoice]SetToPrintedButton, enables the feature. The default setting value 
is N (No). 

With [Invoice]SetToPrintedButton=Y, a Set to Printed button appears on the Edit Invoice Folder 
and Dedicated Billing windows. The following illustrations are of the Edit Invoice Folder window. 

If the invoice status is not Ready to Print, the button is disabled. 

 
If the invoice status is Ready to Print, the button is enabled. 

 
On the Edit Invoice Folder window, clicking Set to Printed simply changes the invoice status to Printed. 

On the Dedicated Billing window, clicking Set to Printed: 

 Changes the status to Printed for the dedicated bill and any associated invoices 

 Creates a master bill 

 Assigns the dedicated bill and associated invoices to the master bill 

In each case, no physical printing takes place. 
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2021.1.1.2019 Service Pack 

Resolved issue 

Planning Worksheet 
TTESUITE-203021 

For consolidated orders, older versions of TMWSuite handled redelivery dates differently in the outbound 
view. With newer versions, the minimum date in the Date Promised column was incorrect. 

This SQL code resolves the issue. 

update @ttbl1   

 set ord_datepromised = (select min (ord_datepromised)  

FROM orderheader (nolock) join stops on stops.ord_hdrnumber = 

orderheader.ord_hdrnumber  

where t.mov_number = stops.mov_number)   

  FROM @ttbl1 t 
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